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1 General
1.1 Copyright © VIPA GmbH

This document contains proprietary information of VIPA and is not to
be disclosed or used except in accordance with applicable agree-
ments.
This material is protected by the copyright laws. It may not be repro-
duced, distributed, or altered in any fashion by any entity (either
internal or external to VIPA), except in accordance with applicable
agreements, contracts or licensing, without the express written con-
sent of VIPA and the business management owner of the material.
For permission to reproduce or distribute, please contact: VIPA,
Gesellschaft für Visualisierung und Prozessautomatisierung mbH
Ohmstraße 4, D-91074 Herzogenaurach, Germany
Tel.: +49 9132 744 -0
Fax.: +49 9132 744-1864
EMail: info@vipa.de
http://www.vipa.com

Every effort has been made to ensure that the information
contained in this document was complete and accurate at
the time of publishing. Nevertheless, the authors retain the
right to modify the information.
This customer document describes all the hardware units
and functions known at the present time. Descriptions may
be included for units which are not present at the customer
site. The exact scope of delivery is described in the
respective purchase contract.

Hereby, VIPA GmbH declares that the products and systems are in
compliance with the essential requirements and other relevant provi-
sions. Conformity is indicated by the CE marking affixed to the
product.

For more information regarding CE marking and Declaration of Con-
formity (DoC), please contact your local VIPA customer service
organization.

All Rights Reserved

CE Conformity Declara-
tion

Conformity Information

VIPA System 200V General
Copyright © VIPA GmbH
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VIPA, SLIO, System 100V, System 200V, System 300V, System
300S, System 400V, System 500S and Commander Compact are
registered trademarks of VIPA Gesellschaft für Visualisierung und
Prozessautomatisierung mbH.
SPEED7 is a registered trademark of profichip GmbH.
SIMATIC, STEP, SINEC, TIA Portal, S7-300 and S7-400 are regis-
tered trademarks of Siemens AG.
Microsoft and Windows are registered trademarks of Microsoft Inc.,
USA.
Portable Document Format (PDF) and Postscript are registered trade-
marks of Adobe Systems, Inc.
All other trademarks, logos and service or product marks specified
herein are owned by their respective companies.

Contact your local VIPA Customer Service Organization representa-
tive if you wish to report errors or questions regarding the contents of
this document. If you are unable to locate a customer service centre,
contact VIPA as follows:
VIPA GmbH, Ohmstraße 4, 91074 Herzogenaurach, Germany
Telefax: +49 9132 744-1204
EMail: documentation@vipa.de

Contact your local VIPA Customer Service Organization representa-
tive if you encounter problems with the product or have questions
regarding the product. If you are unable to locate a customer service
centre, contact VIPA as follows:
VIPA GmbH, Ohmstraße 4, 91074 Herzogenaurach, Germany
Tel.: +49 9132 744-1150 (Hotline)
EMail: support@vipa.de

1.2 About this manual
This manual describes the CPU 215-2BE06 of the System 200V from
VIPA. It contains a description of the construction, project implemen-
tation and usage.

Product Order number as of state:
  CPU-HW CPU-FW CP-FW
CPU 21xPG 215-2BE06 01 V 4.2.1 V 2.7.4.5

The manual is targeted at users who have a background in automa-
tion technology.

The manual consists of chapters. Every chapter provides a self-con-
tained description of a specific topic.

Trademarks

Information product
support

Technical support

Objective and contents

Target audience

Structure of the manual

VIPA System 200VGeneral
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The following guides are available in the manual:
n An overall table of contents at the beginning of the manual
n References with page numbers

The manual is available in:
n printed form, on paper
n in electronic form as PDF-file (Adobe Acrobat Reader)

Important passages in the text are highlighted by following icons and
headings:

DANGER!
Immediate or likely danger. Personal injury is possible.

CAUTION!
Damages to property is likely if these warnings are not
heeded.

Supplementary information and useful tips.

1.3 Safety information
The system is constructed and produced for:
n communication and process control
n general control and automation tasks
n industrial applications
n operation within the environmental conditions specified in the

technical data
n installation into a cubicle

DANGER!
This device is not certified for applications in
– in explosive environments (EX-zone)

The manual must be available to all personnel in the
n project design department
n installation department
n commissioning
n operation

Guide to the document

Availability

Icons Headings

Applications con-
forming with specifica-
tions

Documentation

VIPA System 200V General
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CAUTION!
The following conditions must be met before using or
commissioning the components described in this
manual:
– Hardware modifications to the process control system

should only be carried out when the system has been
disconnected from power!

– Installation and hardware modifications only by prop-
erly trained personnel.

– The national rules and regulations of the respective
country must be satisfied (installation, safety, EMC ...)

National rules and regulations apply to the disposal of the unit!Disposal

VIPA System 200VGeneral

Safety information

HB97 | CPU | 215-2BE06 | GB | 16-17 8



2 Basics and Assembly
2.1 Safety information for users

VIPA modules make use of highly integrated components in MOS-
Technology. These components are extremely sensitive to over-vol-
tages that can occur during electrostatic discharges. The following
symbol is attached to modules that can be destroyed by electrostatic
discharges.

The Symbol is located on the module, the module rack or on packing
material and it indicates the presence of electrostatic sensitive equip-
ment. It is possible that electrostatic sensitive equipment is destroyed
by energies and voltages that are far less than the human threshold
of perception. These voltages can occur where persons do not dis-
charge themselves before handling electrostatic sensitive modules
and they can damage components thereby, causing the module to
become inoperable or unusable. Modules that have been damaged
by electrostatic discharges can fail after a temperature change,
mechanical shock or changes in the electrical load. Only the conse-
quent implementation of protection devices and meticulous attention
to the applicable rules and regulations for handling the respective
equipment can prevent failures of electrostatic sensitive modules.

Modules must be shipped in the original packing material.

When you are conducting measurements on electrostatic sensitive
modules you should take the following precautions:
n Floating instruments must be discharged before use.
n Instruments must be grounded.
Modifying electrostatic sensitive modules you should only use sol-
dering irons with grounded tips.

CAUTION!
Personnel and instruments should be grounded when
working on electrostatic sensitive modules.

Handling of electro-
static sensitive modules

Shipping of modules

Measurements and
alterations on electro-
static sensitive modules

VIPA System 200V Basics and Assembly
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2.2 System conception
The System 200V is a modular automation system for assembly on a
35mm profile rail. By means of the peripheral modules with 4, 8 and
16 channels this system may properly be adapted matching to your
automation tasks.

The System 200V consists of the following components:
n Head modules like CPU and bus coupler
n Periphery modules like I/O, function and communication modules
n Power supplies
n Extension modules

With a head module CPU respectively bus interface and DC 24V
power supply are integrated to one casing. Via the integrated power
supply the CPU respectively bus interface is power supplied as well
as the electronic of the connected periphery modules

The modules are direct installed on a 35mm profile rail and connected
to the head module by a bus connector, which was mounted on the
profile rail before. The periphery modules are equipped with a 10pin
respectively 18pin connector with recessed labelling. This connector
provides the electrical interface for the signalling and supplies lines of
the modules.

Overview

Components

Head modules

Periphery modules

VIPA System 200VBasics and Assembly

System conception
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With the System 200V the DC 24V power supply can take place
either externally or via a particularly for this developed power supply.
The power supply may be mounted on the profile rail together with
the System 200V modules. It has no connector to the back-plane bus.

The expansion modules are complementary modules providing 2- or
3wire connection facilities. The modules are not connected to the
backplane bus.

n Profile rail 35mm
n Dimensions of the basic enclosure:

– 1tier width: (HxWxD) in mm: 76x25.4x74 in inches: 3x1x3
– 2tier width: (HxWxD) in mm: 76x50.8x74 in inches: 3x2x3

Power supplies

Extension modules

Structure/dimensions

VIPA System 200V Basics and Assembly
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1 Head module (double width)
2 Head module (double width)
3 Periphery modules
4 Guide rails
Please note that you can only install header modules, like the CPU,
the PC and couplers at slot 1 or 1 and 2 (for double width modules).

A maximum of 32 modules can be connected at the back
plane bus. Take attention that here the maximum sum cur-
rent of 3.5A is not exceeded. Please install modules with a
high current consumption directly beside the header
module.

2.3 Dimensions
n 2tier width (HxWxD) in mm: 76 x 50.8 x 74

Installation

Dimensions basic
enclosure

Installation dimensions

VIPA System 200VBasics and Assembly

Dimensions
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CPUs
here with EasyConn plug from VIPA

2.4 Mounting
The modules are each installed on a 35mm profile rail and connected
via a bus connector. Before installing the module the bus connector is
to be placed on the profile rail before.

For installation the following 35mm profile rails may be used:

Order number Designation Description
290-1AF00 35mm profile rail Length 2000mm, height 15mm

290-1AF30 35mm profile rail Length 530mm, height 15mm

System 200V modules communicate via a backplane bus connector.
The backplane bus connector is isolated and available from VIPA in
of 1-, 2-, 4- or 8tier width. The following figure shows a 1tier con-
nector and a 4tier connector bus:

Installed and wired
dimensions

General

Profile rail

Bus connector

VIPA System 200V Basics and Assembly

Mounting
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The bus connector is to be placed on the profile rail until it clips in its
place and the bus connections look out from the profile rail.

Bus connector

Order number Designation Description
290-0AA10 Bus connector 1tier

290-0AA20 Bus connector 2tier

290-0AA40 Bus connector 4tier

290-0AA80 Bus connector 8tier

VIPA System 200VBasics and Assembly

Mounting
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1 Head module (double width)
2 Head module (single width)
3 Periphery modules
4 Guide rails
The figure shows the installation of a 4tier width bus connector in a
profile rail and the slots for the modules. The different slots are
defined by guide rails.

n Use bus connectors as long as possible.
n Sort the modules with a high current consumption right beside the

header module. In the service area of www.vipa.com a list of cur-
rent consumption of every System 200V module can be found.

Installation on a profile
rail

Assembly regarding the
current consumption

VIPA System 200V Basics and Assembly

Mounting
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Please regard the allowed environmental temperatures:
1 horizontal assembly: from 0 to 60°C
2 vertical assembly: from 0 to 40°C
3 lying assembly: from 0 to 40°C
The horizontal assembly always starts at the left side with a header
module, then you install the peripheral modules beside to the right.
You may install up to 32 peripheral modules.

Please regard at installation!

1. Turn off the power supply before you install or remove any
modules!

2. Make sure that a clearance of at least 60mm exists above and
80mm below the middle of the profile rail.

1 Head module (double width)
2 Head module (single width)
3 Periphery modules
4 Guide rails

1. Every row must be completed from left to right and it has to start
with a header module.

2. Modules are to be installed side by side. Gaps are not permitted
between the modules since this would interrupt the backplane
bus.

3. A module is only installed properly and connected electrically
when it has clicked into place with an audible click.

4. Slots after the last module may remain unoccupied.

A maximum of 32 modules can be connected at the back
plane bus. Take attention that here the maximum sum
current of 3.5A is not exceeded!

Assembly possibilities

VIPA System 200VBasics and Assembly

Mounting
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1. Install the profile rail. Make sure that a clearance of at least
60mm exists above and 80mm below the middle of the profile
rail.

2. Press the bus connector into the profile rail until it clips securely
into place and the bus-connectors look out from the profile rail.
This provides the basis for the installation of your modules.

1 Head module (double width)
2 Head module (single width)
3 Periphery modules
4 Guide rails
3. Start at the outer left location with the installation of your header

module and install the peripheral modules to the right of this.
4. Insert the module that you are installing into the profile rail at an

angle of 45 degrees from the top and rotate the module into
place until it clicks into the profile rail with an audible click. The
proper connection to the backplane bus can only be guaranteed
when the module has properly clicked into place.

CAUTION!
Power must be turned off before modules are installed or
removed!

Mounting procedure

VIPA System 200V Basics and Assembly

Mounting
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2.5 Demounting and module exchange

1. Remove if exists the wiring to the module, by pressing both
locking lever on the connector and pulling the connector.

2. The casing of the module has a spring loaded clip at the bottom
by which the module can be removed. Insert as shown, a screw-
driver into the clip.

3. The clip is unlocked by pressing the screwdriver in an upward
direction.

4. Pull the module.
5. Withdraw the module with a slight rotation to the top.

CAUTION!
Power must be turned off before modules are installed or
removed!
Please regard that the backplane bus is interrupted at the
point where the module was removed!

Demounting

VIPA System 200VBasics and Assembly

Demounting and module exchange
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2.6 Wiring
Most of the periphery modules are equipped with a 10pin respectively
18pin connector. This connector provides the electrical interface for
the signalling and supplies lines of the modules. Terminals with spring
clamp technology are used for wiring. The spring clamp technology
allows quick and easy connection of your signal and supply lines. In
contrast to screw terminal connections this type of connection is
vibration proof. The pin assignment of the periphery modules can be
found in the description of the modules. You can use wires with a
cross section of 0.08mm2 up to 2.5mm2 (up to 1.5mm2 for 18pin con-
nectors). The figure shows a module with a 10pole connector:

1 Locking lever
2 Pin no. at the module
3 Pin no. at the connector
4 Wiring port
5 Opening for screwdriver

The spring-clip is destroyed if you push the screwdriver
into the wire port! Make sure that you only insert the
screwdriver into the square hole of the connector!

Overview

VIPA System 200V Basics and Assembly
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1. Install the connector on the module until it locks with an audible
click. For this purpose you press the two clips together as
shown.
ð The connector is now in a permanent position and can easily

be wired.

2. The following section shows the wiring procedure from top view.
Insert a suited screwdriver at an angel into the square opening
as shown.

3. Press and hold the screwdriver in the opposite direction to open
the contact spring.

4. Insert the stripped end of wire into the round opening. You can
use wires with a cross section of 0.08mm2 up to 2.5mm2

(1.5mm2 for 18pin connectors).
5. By removing the screwdriver, the wire is securely fixed via the

spring contact to the connector.

Wire the power supply connections first followed by the
signal cables (inputs and outputs).

2.7 Installation guidelines
The installation guidelines contain information about the interference
free deployment of a PLC system. There is the description of the
ways, interference may occur in your PLC, how you can make sure
the electromagnetic compatibility (EMC), and how you manage the
isolation.

Electromagnetic compatibility (EMC) means the ability of an electrical
device, to function error free in an electromagnetic environment
without being interfered respectively without interfering the environ-
ment.
The components of VIPA are developed for the deployment in indus-
trial environments and meets high demands on the EMC. Neverthe-
less you should project an EMC planning before installing the compo-
nents and take conceivable interference causes into account.

Wiring procedure

General

What does EMC mean?

VIPA System 200VBasics and Assembly

Installation guidelines
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Electromagnetic interferences may interfere your control via different
ways:
n Electromagnetic fields (RF coupling)
n Magnetic fields with power frequency
n Bus system
n Power supply
n Protected earth conductor
Depending on the spreading medium (lead bound or lead free) and
the distance to the interference cause, interferences to your control
occur by means of different coupling mechanisms.
There are:
n galvanic coupling
n capacitive coupling
n inductive coupling
n radiant coupling

In the most times it is enough to take care of some elementary rules
to guarantee the EMC. Please regard the following basic rules when
installing your PLC.
n Take care of a correct area-wide grounding of the inactive metal

parts when installing your components.
– Install a central connection between the ground and the pro-

tected earth conductor system.
– Connect all inactive metal extensive and impedance-low.
– Please try not to use aluminium parts. Aluminium is easily oxi-

dizing and is therefore less suitable for grounding.
n When cabling, take care of the correct line routing.

– Organize your cabling in line groups (high voltage, current
supply, signal and data lines).

– Always lay your high voltage lines and signal respectively data
lines in separate channels or bundles.

– Route the signal and data lines as near as possible beside
ground areas (e.g. suspension bars, metal rails, tin cabinet).

n Proof the correct fixing of the lead isolation.
– Data lines must be laid isolated.
– Analog lines must be laid isolated. When transmitting signals

with small amplitudes the one sided laying of the isolation may
be favourable.

– Lay the line isolation extensively on an isolation/protected
earth conductor rail directly after the cabinet entry and fix the
isolation with cable clamps.

– Make sure that the isolation/protected earth conductor rail is
connected impedance-low with the cabinet.

– Use metallic or metallised plug cases for isolated data lines.

Possible interference
causes

Basic rules for EMC

VIPA System 200V Basics and Assembly
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n In special use cases you should appoint special EMC actions.
– Consider to wire all inductivities with erase links.
– Please consider luminescent lamps can influence signal lines.

n Create a homogeneous reference potential and ground all elec-
trical operating supplies when possible.
– Please take care for the targeted employment of the grounding

actions. The grounding of the PLC serves for protection and
functionality activity.

– Connect installation parts and cabinets with your PLC in star
topology with the isolation/protected earth conductor system.
So you avoid ground loops.

– If there are potential differences between installation parts and
cabinets, lay sufficiently dimensioned potential compensation
lines.

Electrical, magnetically and electromagnetic interference fields are
weakened by means of an isolation, one talks of absorption. Via the
isolation rail, that is connected conductive with the rack, interference
currents are shunt via cable isolation to the ground. Here you have to
make sure, that the connection to the protected earth conductor is
impedance-low, because otherwise the interference currents may
appear as interference cause.
When isolating cables you have to regard the following:
n If possible, use only cables with isolation tangle.
n The hiding power of the isolation should be higher than 80%.
n Normally you should always lay the isolation of cables on both

sides. Only by means of the both-sided connection of the isolation
you achieve high quality interference suppression in the higher
frequency area. Only as exception you may also lay the isolation
one-sided. Then you only achieve the absorption of the lower fre-
quencies. A one-sided isolation connection may be convenient, if:
– the conduction of a potential compensating line is not possible.
– analog signals (some mV respectively µA) are transferred.
– foil isolations (static isolations) are used.

n With data lines always use metallic or metallised plugs for serial
couplings. Fix the isolation of the data line at the plug rack. Do not
lay the isolation on the PIN 1 of the plug bar!

n At stationary operation it is convenient to strip the insulated cable
interruption free and lay it on the isolation/protected earth con-
ductor line.

n To fix the isolation tangles use cable clamps out of metal. The
clamps must clasp the isolation extensively and have well contact.

n Lay the isolation on an isolation rail directly after the entry of the
cable in the cabinet. Lead the isolation further on to your PLC and
don't lay it on there again!

CAUTION!
Please regard at installation!
At potential differences between the grounding points,
there may be a compensation current via the isolation con-
nected at both sides.
Remedy: Potential compensation line

Isolation of conductors

VIPA System 200VBasics and Assembly
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2.8 General data
n Wiring by means of spring pressure connections (CageClamps) at

the front-facing connector, core cross-section 0.08 ... 2.5mm2 or
1.5 mm2 (18pole plug)

n Complete isolation of the wiring when modules are exchanged
n Every module is isolated from the backplane bus

Conformity and approval
Conformity

CE 2014/35/EU Low-voltage directive

2014/30/EU EMC directive

Approval

UL UL 508 Approval for USA and Canada

others

RoHS 2011/65/EU Product is lead-free; Restriction of the use of
certain hazardous substances in electrical and
electronic equipment

Protection of persons and device protection
Type of protection - IP20

Electrical isolation

to the field bus - electrically isolated

to the process level - electrically isolated

Insulation resistance  -

Insulation voltage to reference earth

Inputs / outputs - AC / DC 50V, test voltage AC 500V

Protective measures - against short circuit

Environmental conditions to EN 61131-2
Climatic

Storage / transport EN 60068-2-14 -25…+70°C

Operation

Horizontal installation hanging EN 61131-2 0…+60°C

Horizontal installation lying EN 61131-2 0…+40°C

Vertical installation EN 61131-2 0…+40°C

Air humidity EN 60068-2-30 RH1 (without condensation, rel. humidity 10…
95%)

Pollution EN 61131-2 Degree of pollution 2

Reliability

General data

VIPA System 200V Basics and Assembly
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Environmental conditions to EN 61131-2
Installation altitude max. - 2000m

Mechanical

Oscillation EN 60068-2-6 1g, 9Hz ... 150Hz

Shock EN 60068-2-27 15g, 11ms

Mounting conditions
Mounting place - In the control cabinet

Mounting position - Horizontal hanging, lying horizontally and ver-
tical

EMC Standard Comment
Emitted interfer-
ence

EN 61000-6-4 Class A (Industrial area)

Noise immunity
zone B

EN 61000-6-2 Industrial area
 EN 61000-4-2 ESD

8kV at air discharge (degree of severity 3),
4kV at contact discharge (degree of severity
2)

EN 61000-4-3 HF field immunity (casing)
80MHz … 1000MHz, 10V/m, 80% AM (1kHz)
1.4GHz ... 2.0GHz, 3V/m, 80% AM (1kHz)
2GHz ... 2.7GHz, 1V/m, 80% AM (1kHz)

EN 61000-4-6 HF conducted
150kHz … 80MHz, 10V, 80% AM (1kHz)

EN 61000-4-4 Burst, degree of severity 3

EN 61000-4-5 Surge, installation class 3 *
*) Due to the high-energetic single pulses with Surge an appropriate external protective circuit with lightning protection elements like conductors
for lightning and overvoltage is necessary.

VIPA System 200VBasics and Assembly
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3 Hardware description
3.1 Properties

n Instruction set compatible with Siemens STEP®7
n Configuration by means of the Siemens SIMATIC manager
n Integrated V-Bus controller for controlling System 200V periph-

erals
n Integrated 24V power supply
n Total address range: 1024byte inputs, 1024byte outputs

(128byte process image each)
n 128kbyte of work memory "on board"
n 192kbyte of load memory "on board"
n MMC slot (for user program)
n Battery backed clock
n MP2I interface for data transfer
n Integrated Ethernet PG/OP channel with transfer rate

10/100MBit/s
n Status LEDs for operating mode and diagnostics

Type Order number Description
CPU 215PG 215-2BE06 CPU with Ethernet PG/OP channel and

128/192kbyte of work/load memory

CPU 215-2BE06

Ordering data

VIPA System 200V Hardware description

Properties
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3.2 Structure
3.2.1 General

1 Operating mode switch
2 LEDs of the CPU
3 Slot for MMC memory card
4 MP2I interface
5 Slot for DC 24V power supply
6 LEDs of the Ethernet PG/OP channel
7 Ethernet interface of the Ethernet PG/OP channel

3.2.2 Interfaces

The CPU has an internal power supply. This is connected to an
external supply voltage via two terminals located on the front of the
unit.
n The power supply requires DC 24V. In addition to the electronic

circuitry of the CPU this supply voltage is used for the modules
connected to the backplane bus.

n The electronic circuitry of the CPU is not dc-insulated from the
supply voltage. The power supply is protected against reverse
polarity and short circuits.

Please ensure that the polarity of the supply voltage is cor-
rect.

CPU 215-2BE06

Power supply

VIPA System 200VHardware description
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n The MPI unit provides the link for the data transfer between the
CPU and the PC.

n Via bus communication you are able to exchange program and
data between different CPUs that are linked over MPI.

n For a serial exchange between the partners you normally need a
special MPI-converter. But now you are also able to use the VIPA
"Green Cable" order number: 950-0KB00

n This allows you to establish a serial peer-to-peer connection with
VIPA system components over the MPI interface.

n Please regard the Ä ‘Hints for the deployment of the MPI inter-
face’ on page 38.

8pin RJ45 jack:
n The RJ45 jack serves the interface to the Ethernet PG/OP

channel.
n This interface allows you to program res. remote control your

CPU.
n Configurable connections are not possible.
n For online access to the CPU via Ethernet PG/OP channel valid

IP address parameters have to be assigned to this.
n Ä ‘Hardware configuration - Ethernet PG/OP channel’ on page 41

3.2.3 Memory management
The CPU 215-2BE06 has an integrated work memory and a load
memory. The memories are battery-buffered.
n 192kbyte load memory
n 128kbyte work memory

3.2.4 Storage media slot
n As external storage medium for applications and firmware you

may use a MMC storage module (Multimedia card) from VIPA
(Order number: 953-0KX10).

n The VIPA storage media are pre-formatted with the PC format
FAT16 and can be accessed via a card reader.

n After PowerON respectively an overall reset the CPU checks, if
there is a storage medium with data valid for the CPU.

n Push the memory card into the slot until it snaps in leaded by a
spring mechanism. This ensures contacting.

3.2.5 Battery backup for clock and RAM
A rechargeable battery is installed on the CPU 215-2BE06 to safe-
guard the contents of the RAM when power is removed. This battery
is also used to buffer the internal clock. The rechargeable battery is
maintained by a charging circuit that receives its power from the
internal power supply and that maintain the clock and RAM for a max.
period of 30 days.

MP2I interface

Ethernet PG/OP channel

Memory

VIPA System 200V Hardware description
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CAUTION!
– Due to a long storage of the CPU, the battery may be

discharged excessively. Please connect the CPU at
least for 24 hours to the power supply, to achieve the
full buffer capacity.

– After a power reset and with an empty battery the CPU
starts with a BAT error and executes an overall reset,
because with an empty battery the RAM content is
undefined.

3.2.6 Operating mode switch
n With the operating mode switch you may switch the CPU between

STOP and RUN.
n During the transition from STOP to RUN the operating mode

START-UP is driven by the CPU.
n By Switching to MR (Memory Reset) you request an overall reset

with following load from MMC, if a project there exists.

3.2.7 Storage media slot
n As external storage medium for applications and firmware you

may use a MMC storage module (Multimedia card) from VIPA
(Order number: 953-0KX10).

n The VIPA storage media are pre-formatted with the PC format
FAT16 and can be accessed via a card reader.

n After PowerON respectively an overall reset the CPU checks, if
there is a storage medium with data valid for the CPU.

n Push the memory card into the slot until it snaps in leaded by a
spring mechanism. This ensures contacting.

VIPA System 200VHardware description

Structure > Storage media slot
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3.2.8 LEDs
As soon as the CPU is supplied with 5V, the green PW-LED (Power)
is on.

R
(RUN)

S
(STOP)

SF
(SFAIL)

FC
(FRCE)

MC
(MMC)

Meaning

green yellow red yellow yellow  

 

○ ● X X X CPU is in STOP state.

B ○ X X X CPU is in start-up state, the RUN LED blinks during
operating OB100 at least for 3s.

● ○ ○ X X CPU is in state RUN without error.

X X ● X X There is a system fault. More information may be
found in the diagnostics buffer of the CPU.

X X X ● X Variables are forced.

X X X X B Access to the memory card.

Overall reset

○ B X X X Overall reset is executed.

○ ● X X X Overall reset finished.

Factory reset

● ● ○ ○ ○ Factory reset is executed.

○ ● ○ ○ ○ Factory reset finished without error.

Firmware update

○ ○ B B ● The alternate blinking indicates that there is new
firmware on the memory card.

○ ● ● ● ● Firmware update finished without error.

○ B B B B Blinking: Error during Firmware update.

on: ● | off: ○ | blinking: B | not relevant: X

LEDs CPU

VIPA System 200V Hardware description
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In addition the CPU has more LEDs that display the communication
of the Ethernet PG/OP channel. The LEDs are located on the front of
the left side of the housing.

Name Color Description
RN

(RUN)
green ● Ethernet PG/OP channel is initialized

○ Ethernet PG/OP channel is deactivated

ST
(STOP)

gelb ● Ethernet PG/OP channel is deactivated

○ Ethernet PG/OP channel is initialized

IF
(Internal error)

red ● Ethernet PG/OP channel reports internal error

L/A
(Link/Activity)

green ● Ethernet PG/OP channel is physically connected to Ethernet

○ There is no physically connection to Ethernet.

B Irregular flashing: Indicates communication of the Ethernet
PG/OP channel via Ethernet

S
(Speed)

green ● Transfer speed: 100MBit/s

○ Transfer speed: 10MBit/s

on: ● | off: ○ | blinking: B

3.3 Technical data
Order no. 215-2BE06
Type CPU 215PG

Technical data power supply
Power supply (rated value) DC 24 V

Power supply (permitted range) DC 20.4...28.8 V

Reverse polarity protection ü

Current consumption (no-load operation) 140 mA

Current consumption (rated value) 1.5 A

Inrush current 65 A

I²t 0.75 A²s

Max. current drain at backplane bus 3 A

Max. current drain load supply -

Power loss 6 W

Load and working memory
Load memory, integrated 192 KB

Load memory, maximum 192 KB

LEDs Ethernet PG/OP
channel

VIPA System 200VHardware description
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Order no. 215-2BE06
Work memory, integrated 128 KB

Work memory, maximal 128 KB

Memory divided in 50% program / 50% data -

Memory card slot MMC-Card with max. 512 MB

Hardware configuration
Racks, max. 4

Modules per rack, max. total max. 32

Number of integrated DP master -

Number of DP master via CP 8

Operable function modules 32

Operable communication modules PtP 32

Operable communication modules LAN -

Command processing times
Bit instructions, min. 0.18 µs

Word instruction, min. 0.78 µs

Double integer arithmetic, min. 1.8 µs

Floating-point arithmetic, min. 40 µs

Timers/Counters and their retentive charac-
teristics
Number of S7 counters 256

S7 counter remanence adjustable 0 up to 64

S7 counter remanence adjustable C0 .. C7

Number of S7 times 256

S7 times remanence adjustable 0 up to 128

S7 times remanence adjustable not retentive

Data range and retentive characteristic
Number of flags 8192 Bit

Bit memories retentive characteristic adjustable adjustable 0 up to 256

Bit memories retentive characteristic preset MB0 .. MB15

Number of data blocks 2047

Max. data blocks size 16 KB

Number range DBs 1 ... 2047

Max. local data size per execution level 1024 Byte

Max. local data size per block 1024 Byte

Blocks
Number of OBs 14

VIPA System 200V Hardware description

Technical data
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Order no. 215-2BE06
Maximum OB size 16 KB

Total number DBs, FBs, FCs -

Number of FBs 1024

Maximum FB size 16 KB

Number range FBs 0 ... 1023

Number of FCs 1024

Maximum FC size 16 KB

Number range FCs 0 ... 1023

Maximum nesting depth per priority class 8

Maximum nesting depth additional within an
error OB

1

Time
Real-time clock buffered ü

Clock buffered period (min.) 30 d

Type of buffering Vanadium Rechargeable Lithium Battery

Load time for 50% buffering period 20 h

Load time for 100% buffering period 48 h

Accuracy (max. deviation per day) 10 s

Number of operating hours counter 8

Clock synchronization -

Synchronization via MPI -

Synchronization via Ethernet (NTP) -

Address areas (I/O)
Input I/O address area 1024 Byte

Output I/O address area 1024 Byte

Process image adjustable -

Input process image preset 128 Byte

Output process image preset 128 Byte

Input process image maximal 128 Byte

Output process image maximal 128 Byte

Digital inputs 8192

Digital outputs 8192

Digital inputs central 512

Digital outputs central 512

Integrated digital inputs -

Integrated digital outputs -

VIPA System 200VHardware description

Technical data
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Order no. 215-2BE06
Analog inputs 512

Analog outputs 512

Analog inputs, central 128

Analog outputs, central 128

Integrated analog inputs -

Integrated analog outputs -

Communication functions
PG/OP channel ü

Global data communication ü

Number of GD circuits, max. 4

Size of GD packets, max. 22 Byte

S7 basic communication ü

S7 basic communication, user data per job 76 Byte

S7 communication ü

S7 communication as server ü

S7 communication as client -

S7 communication, user data per job 160 Byte

Number of connections, max. 16

Functionality Sub-D interfaces
Type MP²I

Type of interface RS485

Connector Sub-D, 9-pin, female

Electrically isolated -

MPI ü

MP²I (MPI/RS232) ü

Point-to-point interface -

5V DC Power supply provided max. 90mA, non-isolated

24V DC Power supply provided max. 100mA, non-isolated

Functionality MPI
Number of connections, max. 16

PG/OP channel ü

Routing -

Global data communication ü

S7 basic communication ü

S7 communication ü

S7 communication as server ü

VIPA System 200V Hardware description
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Order no. 215-2BE06
S7 communication as client -

Transmission speed, min. 19.2 kbit/s

Transmission speed, max. 187.5 kbit/s

Functionality RJ45 interfaces
Type TP

Type of interface Ethernet 10/100 MBit

Connector RJ45

Electrically isolated ü

PG/OP channel ü

Number of connections, max. 8

Productive connections ü

Ethernet communication CP
Number of productive connections, max. 16

Number of productive connections by Siemens
NetPro, max.

16

S7 connections -

User data per S7 connection, max. -

TCP-connections FETCH PASSIV, WRITE PASSIV, Connection
of passive data handling

User data per TCP connection, max. 64 KB

ISO-connections -

User data per ISO connection, max. -

ISO on TCP connections (RFC 1006) FETCH PASSIV, WRITE PASSIV, Connection
of passive data handling

User data per ISO on TCP connection, max. 32 KB

UDP-connections -

User data per UDP connection, max. -

UDP-multicast-connections -

UDP-broadcast-connections -

Datasizes
Input bytes 0

Output bytes 0

Parameter bytes 3

Diagnostic bytes 0

Housing
Material PPE / PA 6.6

Mounting Profile rail 35 mm

VIPA System 200VHardware description

Technical data
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Order no. 215-2BE06
Mechanical data
Dimensions (WxHxD) 50.8 mm x 76 mm x 80 mm

Weight 150 g

Environmental conditions
Operating temperature 0 °C to 60 °C

Storage temperature -25 °C to 70 °C

Certifications
UL certification yes

KC certification -

VIPA System 200V Hardware description
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4 Deployment

4.1 Assembly

Information about assembly and cabling: Ä ‘Mounting’
on page 13

4.2 Start-up behavior
When the CPU is delivered it has been reset. After the power supply
has been switched on, the CPU changes to the operating mode the
operating mode lever shows. After a STOP à RUN transition the
CPU switches to RUN without program.

Due to a long storage of the CPU, the battery may be dis-
charged excessively. Please connect the CPU at least for
24 hours to the power supply, to achieve the full buffer
capacity.

The CPU switches to RUN with the program stored in the battery buf-
fered RAM.

n The accumulator/battery is automatically loaded via the integrated
power supply and guarantees a buffer for max. 30 days. If this
time is exceeded, the battery may be totally discharged. This
means that the battery buffered RAM is deleted.

n In this state, the CPU executes an overall reset because with an
empty battery the RAM content is undefined. If a MMC with a
S7PROG.WLD is plugged, program code and data blocks are
transferred from the MMC into the work memory of the CPU.

n If there is no MMC, the project from the internal Flash is loaded.
n Depending on the position of the operating mode switch, the CPU

remains in STOP respectively switches to RUN. Due to the battery
error the CPU can only boot if there was an OB81 configured.
Otherwise a manual restart (STOP/RUN) respectively PG com-
mand is necessary.

n On a start-up with an empty battery the SF LED is on and thus
points to an entry in the diagnostic buffer.
Ä ‘Diagnostic entries’ on page 56

CAUTION!
After a power reset and with an empty battery the CPU
starts with a BAT error and executes an overall reset.

Turn on power supply

Boot procedure with
valid data in the CPU

Boot procedure with
empty battery

VIPA System 200VDeployment

Start-up behavior
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4.3 Addressing
To provide specific addressing of the installed peripheral modules,
certain addresses must be allocated in the CPU. The CPU contains a
peripheral area (addresses 0 ... 1023) and a process image of the
inputs and the outputs (for both each address 0 ... 127). When the
CPU is initialized it automatically assigns peripheral addresses to the
digital input/output modules starting from 0. If there is no hardware
projecting, analog modules are allocated to even addresses starting
from address 128.

The signaling states of the lower addresses (0 ... 127) are additionally
saved in a special memory area called the process image.
The process image is divided into two parts:
n process image of the inputs (PII)
n process image of the outputs (PIQ)

The process image is updated automatically when a cycle has been
completed.

You may access the modules by means of read or write operations
on the peripheral bytes or on the process image.

Please remember that you may access different modules
by means of read and write operations on the same
address.
The addressing ranges of digital and analog modules are
different when they are addressed automatically.
– Digital modules: 0 ... 127
– Analog modules: 128 ... 1023

Automatic addressing

Signaling states in the
process image

Read/write access

VIPA System 200V Deployment
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The following figure illustrates the automatic allocation of addresses:

You may change the allocated addresses at any time by means of the
Siemens SIMATIC manager. In this way you may also change the
addresses of analog modules to the range covered by the process
image (0 ... 127) and address digital modules above 127. The fol-
lowing pages describe the required preparations and the procedure
for this type of configuration.

4.4 Hints for the deployment of the MPI interface
The MP2I jack combines 2 interfaces in 1:
n MP Interface
n RS232 Interface
Please regard that the RS232 functionality is only available by using
the Green Cable from VIPA.

The MPI provides the data transfer between CPUs and PCs. In a bus
communication you may transfer program and data between the
CPUs interconnected via MPI. Connecting a common MPI cable, the
MPI jack supports the full MPI functionality.

Example for automatic
address allocation

Modifying allocated
addresses by configura-
tion

What is MP2I?

Deployment as MPI

VIPA System 200VDeployment
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CAUTION!
Important notes for the deployment of MPI cables!
Deploying MPI cables at the CPUs from VIPA, you have to
make sure that Pin 1 is not connected. This may cause
transfer problems and in some cases damage the CPU!
Especially PROFIBUS cables from Siemens, like e.g. the
6XV1 830-1CH30, must not be deployed at MP2I jack. For
damages caused by nonobservance of these notes and at
improper deployment, VIPA does not take liability!

For the serial data transfer from your PC, you normally need a MPI
transducer. Fortunately you may also use the "Green Cable" from
VIPA. You can order this under the order no. VIPA 950-0KB00.
The "Green Cable" supports a serial point-to-point connection for data
transfer via the MP2I jack exclusively for VIPA CPUs.

4.5 Hardware configuration - CPU
For the project engineering of the CPU 215-2BE06 and the other
System 200V modules connected to the same VIPA bus, the hard-
ware configurator from Siemens is to be used. To address the directly
plugged peripheral modules, you have to assign a special address in
the CPU to every module. The address allocation and the parameteri-
zation of the modules takes place in the Siemens SIMATIC manager
as a virtual PROFIBUS system. For the PROFIBUS interface is
standardized software sided, the functionality is guaranteed by
including a GSD-file into the Siemens SIMATIC manager. Transfer
your project into the CPU via the MPI interface.

The following conditions must be fulfilled for project engineering:
n The Siemens SIMATIC manager is installed at PC respectively

PG
n The GSD files have been included in Siemens hardware configu-

rator
n Serial connection to the CPU (e.g. MPI-Adapter)

The configuration of the CPU requires a thorough knowl-
edge of the Siemens SIMATIC manager and the hardware
configurator!

Deployment as RS232
interface only via
"Green Cable"

Overview

Requirements

VIPA System 200V Deployment

Hardware configuration - CPU
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1. Go to www.vipa.com > Service > Download > PROFIBUS GSD
files and download the file System_100V_-_200V_Vxxx.zip.

2. Extract the file to your work directory. The vipa_21x.gsd
(German) respectively vipa_21x.gse (English) can be found at
the directory CPU21x.

3. Start the Siemens hardware configurator and close every
project.

4. Go to Options > Install new GSD file.
5. Navigate to the directory CPU21x and choose the corresponding

file vipa_21x.gsd (German) or vipa_21x.gse (English)
ð Now the modules of the VIPA System 200V are integrated in

the hardware catalog at PROFIBUS-DP \ Additional field
devices \ I/O \ VIPA_System_200V.

To be compatible with the Siemens SIMATIC manager the following
steps should be executed:

1. Start the hardware configurator from Siemens with a new
project.

2. Insert a profile rail from the hardware catalog.
3. Place at slot 2 the following CPU from Siemens CPU 315-2DP

(6ES7 315-2AG10-0AB0 V2.6.)
4. For the System 200V create a new PROFIBUS subnet.
5. Attach the slave system "VIPA_CPU21x" to the subnet with

PROFIBUS-Address 1
ð After installing the vipa_21x.gsd the slave system may be

found at the hardware catalog at PROFIBUS DP > Additional
field devices > IO > VIPA_System_200V.

6. Place always at the 1. slot the corresponding 215-2BE06, by
taking it from the hardware catalog.

Including the GSD-file

Proceeding

VIPA System 200VDeployment
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4.6 Hardware configuration - I/O modules
After the hardware configuration of the CPU place the System 200V
modules in the plugged sequence. In order to address the installed
peripheral modules individually, specific addresses in the CPU have
to be assigned to them.

For parameterization double-click during the project engineering at
the slot overview on the module you want to parameterize. In the
appearing dialog window you may set the wanted parameters.

By using the SFCs 55, 56 and 57 you may alter and transfer parame-
ters for wanted modules during runtime. For this you have to store the
module specific parameters in so called "record sets". More detailed
information about the structure of the record sets is to find in the
according module description.

4.7 Hardware configuration - Ethernet PG/OP channel
The CPU has an integrated Ethernet PG/OP channel. This channel
allows you to program and remote control your CPU. With the first
start-up respectively after an overall reset the Ethernet PG/OP
channel does not have any IP address. For online access to the CPU
via Ethernet PG/OP channel valid IP address parameters have to be
assigned to this by means of the Siemens SIMATIC manager. This is
called "initialization".

1. Install your System 200V with your CPU.
2. Wire the system by connecting cables for voltage supply and

signals.

Hardware configuration
of the modules

Parameterization

Parameterization during
runtime

Overview

Assembly and commis-
sioning

VIPA System 200V Deployment
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3. Connect the Ethernet jack of the Ethernet PG/OP channel to
Ethernet.

4. Switch on the power supply.
ð After a short boot time the CP is ready for communication.

He possibly has no IP address data and requires an initiali-
zation.

The initialization via PLC functions takes place with the following pro-
ceeding:

Determine the current Ethernet (MAC) address of your Ethernet
PG/OP channel.
ð This always may be found at a sticker on the left side of the

CPU.

You get valid IP address parameters from your system administrator.
The assignment of the IP address data happens online in the Sie-
mens SIMATIC manager starting with version V 5.3 & SP3 with the
following proceeding:
1. Start the Siemens SIMATIC manager and set via Options > Set

PG/PC interface the access path to "TCP/IP -> Network card ....
".

2. Open with PLC > Edit Ethernet Node the dialog window with the
same name.

3. To get the stations and their MAC address, use the [Browse]
button or type in the MAC Address. The Mac address may be
found at the 1. label beneath the front flap of the CPU.

4. Choose if necessary the known MAC address of the list of found
stations.

"Initialization" via PLC
functions

Assign IP address
parameters

VIPA System 200VDeployment
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5. Either type in the IP configuration like IP address, subnet mask
and gateway. Or your station is automatically provided with IP
parameters by means of a DHCP server. Depending of the
chosen option the DHCP server is to be supplied with MAC
address, equipment name or client ID. The client ID is a numer-
ical order of max. 63 characters. The following characters are
allowed: "hyphen", 0-9, a-z, A-Z

6. Confirm with [Assign IP configuration].

Direct after the assignment the Ethernet PG/OP channel
may be reached online by these address data. The value
remains as long as it is reassigned, it is overwritten by a
hardware configuration or an factory reset is executed.

1. Open the Siemens hardware configurator and configure the
VIPA CPU 215-2BE06 as Siemens CPU 315-2DP (6ES7
315-2AG10-0AB0 V2.6.) which is to be found at SIMATIC 300 \
CPU 300 \ CPU 315-2DP. If needed, parameterize the CPU
315-2DP.

2. Configure in deputy of your CP the CP 343-1 (343-1EX11) from
Siemens at slot 4, to be found at SIMATIC 300 / CP 300 / Indus-
trial Ethernet / CP 343-1.

3. Open the property window via double-click on the CP
343-1EX11 and enter for the CP at "Properties" the IP address
data, which you have assigned before.

4. Transfer your project.

4.8 Setting CPU parameters
Since the CPU from VIPA is to be configured as Siemens CPU
315-2DP (6ES7 315-2AG10-0AB0 V2.6.) in the Siemens hardware
configurator, the parameters of the VIPA CPU may be set with
"Object properties" of the CPU 315-2DP during hardware configura-
tion. Via a double-click on the CPU 315-2DP the parameter window of
the CPU may be accessed. Using the registers you get access to
every standard parameter of the CPU.

Take IP address param-
eters in project

Parameterization via
Siemens CPU

VIPA System 200V Deployment
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4.8.1 Parameter CPU
The CPU does not evaluate each parameter, which may be set at the
hardware configuration. The following parameters are supported by
the CPU at this time:

n Short description: Short description Siemens CPU 315-2DP
(6ES7 315-2AG10-0AB0 V2.6.).

n Order No. / Firmware: Order number and firmware are identical to
the details in the "hardware catalog" window.

n Name: The Name field provides the short description of the CPU.
If you change the name the new name appears in the Siemens
SIMATIC Manager.

n Plant designation: Here is the possibility to specify a plant desig-
nation for the CPU. This plant designation identifies parts of the
plant according to their function. Its structure is hierarchic
according to IEC 1346-1.

n Comment: In this field information about the module may be
entered.

n Startup when expected/actual configuration differs: If the
checkbox for ‘Startup when expected/actual configuration differ’  is
deselected and at least one module is not located at its configured
slot or if another type of module is inserted there instead, then the
CPU does not switch to RUN mode and remains in STOP mode. If
the checkbox for ‘Startup when expected/actual configuration
differ’  is selected, then the CPU starts even if there are modules
not located in their configured slots of if another type of module is
inserted there instead, such as during an initial system start-up.

n Monitoring time for ready message by modules [100ms]: This
operation specifies the maximum time for the ready message of
every configured module after PowerON. Here connected
PROFIBUS DP slaves are also considered until they are parame-
terized. If the modules do not send a ready message to the CPU
by the time the monitoring time has expired, the actual configura-
tion becomes unequal to the preset configuration. Monitoring time
for ready message by modules [100ms]

n Transfer of parameters to modules [100ms]: The maximum time
for the transfer of parameters to parametrizable modules. If not
every module has been assigned parameters by the time this
monitoring time has expired; the actual configuration becomes
unequal to the preset configuration.

Supported parameters

General

Startup

VIPA System 200VDeployment
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n Update OB1 process image cyclically: This parameter is not rele-
vant.

n Scan cycle monitoring time: Here the scan cycle monitoring time
in milliseconds may be set. If the scan cycle time exceeds the
scan cycle monitoring time, the CPU enters the STOP mode.
Possible reasons for exceeding the time are:
– Communication processes
– a series of interrupt events
– an error in the CPU program

n Minimum scan cycle time: This parameter is not relevant.
n Scan cycle load from Communication: This parameter is not rele-

vant.
n Size of the process image input/output area: Here the size of the

process image max. 2048 for the input/output periphery may be
fixed.

n OB85 call up at I/O access error: The preset reaction of the CPU
may be changed to an I/O access error that occurs during the
update of the process image by the system. The VIPA CPU is
preset such that OB 85 is not called if an I/O access error occurs
and no entry is made in the diagnostic buffer either.

n Clock memory: Activate the check box if you want to use clock
memory and enter the number of the memory byte.

The selected memory byte cannot be used for temporary
data storage.

n Number of Memory bytes from MB0: Enter the number of retentive
memory bytes from memory byte 0 onwards.

n Number of S7 Timers from T0: Enter the number of retentive S7
timers from T0 onwards. Each S7 timer occupies 2bytes.

n Number of S7 Counters from C0: Enter the number of retentive S7
counter from C0 onwards.

n Areas: This parameter is not supported.

n Priority: Here the priorities are displayed, according to which the
hardware interrupt OBs are processed (hardware interrupt, time-
delay interrupt, async. error interrupts).

n Priority: Here the priorities may be specified according to which
the time-of-day interrupt is processed. With priority "0" the corre-
sponding OB is deactivated.

n Active: Activate the check box of the time-of-day interrupt OBs if
these are to be automatically started on complete restart.

n Execution: Select how often the interrupts are to be triggered.
Intervals ranging from every minute to yearly are available. The
intervals apply to the settings made for start date and time.

n Start date/time: Enter date and time of the first execution of the
time-of-day interrupt.

n Process image partition: This parameter is not supported.

Cycle/Clock memory

Retentive Memory

Interrupts

Time-of-day interrupts

VIPA System 200V Deployment
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n Priority: Here the priorities may be specified according to which
the corresponding cyclic interrupt is processed. With priority "0"
the corresponding interrupt is deactivated.

n Execution: Enter the time intervals in ms, in which the watchdog
interrupt OBs should be processed. The start time for the clock is
when the operating mode switch is moved from STOP to RUN.

n Phase offset: Enter the delay time in ms for current execution for
the watch dog interrupt. This should be performed if several
watchdog interrupts are enabled. Phase offset allows to distribute
processing time for watchdog interrupts across the cycle.

n Process image partition: This parameter is not supported.

n Level of protection: Here 1 of 3 protection levels may be set to
protect the CPU from unauthorized access.
– Protection level 1 (default setting):

No password adjustable, no restrictions
– Protection level 2 with password:

Authorized users: read and write access
Unauthorized user: read access only

– Protection level 3:
Authorized users: read and write access
Unauthorized user: no read and write access

4.9 Project transfer
There are the following possibilities for project transfer into the CPU:
n Transfer via MPI
n Transfer via Ethernet
n Transfer via MMC when using a MMC programmer

4.9.1 Transfer via MPI
The structure of a MPI net is electrically identical with the structure of
a PROFIBUS net. This means the same rules are valid and you use
the same components for the build-up. The single participants are
connected with each other via bus interface plugs and PROFIBUS
cables. Per default the MPI net runs with 187.5kbaud. VIPA CPUs are
delivered with MPI address 2.

The MPI programming cables are available at VIPA in different var-
iants. The cables provide a RS232 res. USB plug for the PC and a
bus enabled RS485 plug for the CPU. Due to the RS485 connection
you may plug the MPI programming cables directly to an already
plugged plug on the RS485 jack. Every bus participant identifies itself
at the bus with an unique address, in the course of the address 0 is
reserved for programming devices.

A cable has to be terminated with its surge impedance. For this you
switch on the terminating resistor at the first and the last participant of
a network or a segment. Please make sure that the participants with
the activated terminating resistors are always power supplied. Other-
wise it may cause interferences on the bus.

Cyclic interrupts

Protection

Overview

MPI programming cable

Terminating resistor
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Transfer with MPI programming cable (MPI communication)

Transfer via "Green Cable" (serial communication)
Via exclusively direct plugging of the "Green Cable" to a MP2I jack
you may establish a serial connection between PC and CPU. Set the
PC-COM port and the transfer rate 38400Baud at Local port. The set-
tings of the register MPI are ignored at employment of the "Green
Cable".

MPI-Programmierkabel
Currently the VIPA programming cables (950-0KBxx) are
not supported for transfer via MPI. This is only possible
with the programming cable from Siemens. Under Win-
dows® 7 the "Green Cable" (950-0KB00) is not usable.

Hints for configuring a MPI interface are to find in the documentation
of your programming software. The "Green Cable" has the order
number: 950-0KB00.

WARNING!
Please regard, that you may use the "Green Cable" exclu-
sively at VIPA CPUs with MP2I-interface! Please regard
the hints for deploying the Green Cable and the MP2I jack!

1. Connect your PC to the MPI jack of your CPU via a MPI pro-
gramming cable.

2. Load your project in the SIMATIC manager from Siemens.
3. Choose in the menu Options > Set PG/PC interface
4. Select in the according list the "PC Adapter (MPI)"; if appropriate

you have to add it first, then click on [Properties].
5. Set in the register MPI the transfer parameters of your MPI net

and type a valid address.

Configure MPI

Approach transfer via
MPI interface
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6. Switch to the register Local connection
7. Set the COM port of the PC and the transfer rate 38400Baud for

the MPI programming cable from VIPA.
8. Via PLC > Load to module you may transfer your project via MPI

to the CPU and save it on a MMC via PLC > Copy RAM to ROM
if one is plugged.

Please make sure to adjust the transfer rate to 38400Baud
when using the "Green Cable" from VIPA.

The Green Cable is a green connection cable, manufactured exclu-
sively for the deployment at VIPA System components. The Green
Cable is a programming and download cable for VIPA CPUs MP2I
jack and VIPA field bus masters. The Green Cable from VIPA is avail-
able under the order no. VIPA 950-0KB00.
The Green Cable allows you to:
n transfer projects serial

– Avoiding high hardware needs (MPI transducer, etc.) you may
realize a serial point-to-point connection via the Green Cable
and the MP2I jack. This allows you to connect components to
your VIPA-CPU that are able to communicate serial via a MPI
adapter like e.g. a visualization system.

n execute firmware updates of the CPUs and field bus masters
– Via the Green Cable and an upload application you may

update the firmware of all recent VIPA CPUs with MP2I jack
and certain field bus masters (see Note).

Important notes for the deployment of the Green Cable
Nonobservance of the following notes may cause dam-
ages on system components. For damages caused by
nonobservance of the following notes and at improper
deployment, VIPA does not take liability!

Note to the application area
The Green Cable may exclusively deployed directly at the
concerning jacks of the VIPA components (in between
plugs are not permitted). E.g. a MPI cable has to be dis-
connected if you want to connect a Green Cable. At this
time, the following components support Green Cable:
VIPA CPUs with MP2I jack and field bus masters from
VIPA.

Note to the lengthening
The lengthening of the Green Cable with another Green
Cable res. The combination with further MPI cables is not
permitted and causes damages of the connected compo-
nents! The Green Cable may only be lengthened with a
1:1 cable (all 9 pins are connected 1:1).

Hints for the Green
Cable
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4.9.2 Transfer via Ethernet
For transfer via Ethernet the CPU has the following interface:
n Ethernet PG/OP channel

So that you may access the Ethernet PG/OP channel you have to
assign IP address parameters by means of the "initialization".
Ä ‘Hardware configuration - Ethernet PG/OP channel’ on page 41

1. For the transfer, connect, if not already done, the appropriate
Ethernet port to your Ethernet.

2. Open your project with the Siemens SIMATIC manager.
3. Set via Options > Set PG/PC Interface the access path to

"TCP/IP -> Network card .... ".
4. Click to PLC > Download

à the dialog "Select target module" is opened.
Select your target module and enter the IP address parameters
of the Ethernet PG/OP channel for connection. Provided that no
new hardware configuration is transferred to the CPU, the
entered Ethernet connection is permanently stored in the project
as transfer channel.

5. With [OK] the transfer is started.

System dependent you get a message that the projected
system differs from target system. This message may be
accepted by [OK].
à Your project is transferred and may be executed in the
CPU after transfer.

4.9.3 Transfer via MMC
The MMC (Memory Card) serves as external transfer and storage
medium. There may be stored several projects and sub-directories on
a MMC storage module. Please regard that your current project is
stored in the root directory and has one of the following file names:
n S7PROG.WLD
n S7PROGF.WLD
n AUTOLOAD.WLD
With File > Memory Card File > New in the Siemens SIMATIC man-
ager a new wld file may be created. After the creation copy the blocks
from the project blocks folder and the System data into the wld file.

The transfer of the application program from the MMC into the CPU
takes place depending on the file name after an overall reset or Pow-
erON.

Initialization

Transfer

Transfer MMC à CPU
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n S7PROG.WLD is read from the MMC after overall reset and trans-
ferred into the battery buffered RAM.

n S7PROGF.WLD is read from the MMC after overall reset and
transferred into the battery buffered RAM and additionally into the
Flash memory. An access to the Flash memory only takes place
at empty battery of the buffer and when no MMC with user pro-
gram is plugged-in.

n AUTOLOAD.WLD is read after PowerON from the MMC and
transferred into the battery-buffered RAM .

During the transfer the "MC" LED blinks. Please regard that your user
memory serves for enough space, otherwise your user program is not
completely loaded and the SF LED gets on. Execute a compression
before the transfer, for this does not happen automatically.

When the MMC has been installed, the write command stores the
content of the battery buffered RAM as S7PROG.WLD on the MMC
and in the internal Flash memory. The write command is controlled by
means of the block area of the Siemens SIMATIC manager PLC >
Copy RAM to ROM. During the write process the "MC"-LED of the
CPU is blinking. When the LED expires the write process is finished.
If this project is to be loaded automatically from the MMC with Pow-
erON, you have to rename this on the MMC to AUTOLOAD.WLD.

After a MMC access, an ID is written into the diagnostic buffer of the
CPU. To monitor the diagnosis entries, you select PLC > Module
Information in the Siemens SIMATIC manager. Via the register "Diag-
nostic Buffer" you reach the diagnosis window. Information about the
Event-IDs can be found at "VIPA specific diagnostic entries".

4.10 Operating modes
The CPU can be in one of 3 operating modes:
n Operating mode STOP
n Operating mode START-UP
n Operating mode RUN
Certain conditions in the operating modes START-UP and RUN
require a specific reaction from the system program. In this case the
application interface is often provided by a call to an organization
block that was included specifically for this event.

n The application program is not processed.
n If there has been a processing before, the values of counters,

timers, flags and the process image are retained during the transi-
tion to the STOP mode.

n Outputs are inhibited, i.e. all digital outputs are disabled.
n RUN-LED (R) off
n STOP-LED (S) on

Transfer CPU à MMC

Transfer control

Overview

Operating mode STOP
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n During the transition from STOP to RUN the system calls the
start-up organization block OB 100. The processing time for this
OB is not monitored. The start-up OB may issue calls to other
blocks.

n All digital outputs are disabled during the start-up, i.e. outputs are
inhibited.

n RUN-LED blinks as soon as the OB 100 is operated and for at
least 3s, even if the start-up time is shorter or the CPU gets to
STOP due to an error. This indicates the start-up.

n STOP-LED off
When the CPU has completed the start-up OB, it assumes the oper-
ating mode RUN.

n The application program in OB 1 is processed in a cycle. Under
the control of alarms other program sections can be included in
the cycle.

n All timers and counters being started by the program are active
and the process image is updated with every cycle.

n The BASP-signal (outputs inhibited) is deactivated, i.e. all digital
outputs are enabled.

n RUN-LED on
n STOP-LED off

The CPUs include security mechanisms like a Watchdog (100ms)
and a parameterizable cycle time surveillance (parameterizable min.
1ms) that stop res. execute a RESET at the CPU in case of an error
and set it into a defined STOP state. The VIPA CPUs are developed
function secure and have the following system properties:

Event concerns Effect
RUN ® STOP general BASP (Befehls-Ausgabe-Sperre, i.e. com-

mand output lock) is set.

 central digital outputs The outputs are disabled.

 central analog outputs The outputs are disabled.
n Voltage outputs issue 0V
n Current outputs 0...20mA issue 0mA
n Current outputs 4...20mA issue 4mA
If configured also substitute values may be
issued.

 decentral outputs Same behavior as the central digital/analog
outputs.

 decentral inputs The inputs are cyclically be read by the
decentralized station and the recent values
are put at disposal.

STOP ® RUN res.
PowerON

general First the PII is deleted, then OB 100 is
called. After the execution of the OB, the
BASP is reset and the cycle starts with:
Delete PIO ® Read PII ® OB 1.

Operating mode
START-UP

Operating mode RUN

Function security
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Event concerns Effect
 decentral inputs The inputs are once be read by the decen-

tralized station and the recent values are
put at disposal.

RUN general The program execution happens cyclically
and can therefore be foreseen: Read PII ®
OB 1 ® Write PIO.

PII: Process image inputs, PIO: Process image outputs

4.11 Overall reset
During the overall reset the entire user memory is erased. Data
located in the memory card is not affected.
You have 2 options to initiate an overall reset:
n initiate the overall reset by means of the function selector switch
n initiate the overall reset by means of the configuration software

e.g. Siemens SIMATIC manager

You should always issue an overall reset to your CPU
before loading an application program into your CPU to
ensure that all blocks have been cleared from the CPU.

The operating mode of the CPU is STOP. Place the function
selector on the CPU in position "ST"
ð the S-LED is on.

1. Place the function selector in the position MR and hold it in this
position for app. 3 seconds.
ð The S-LED changes from blinking to permanently on.

2. Place the function selector in the position ST and switch it to MR
and quickly back to ST within a period of less than 3 seconds.
ð The S-LED blinks (overall reset procedure).

Overview

Overall reset by means
of the function selector
Condition

Overall reset
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3. The overall reset has been completed when the S-LED is on
permanently.
ð The S-LED is on.

The following figure illustrates the above procedure:

1. If there is a project S7PROG.WLD on the MMC, the CPU
attempts to reload this project from MMC.
ð The MC LED is on.

2. When the reload has been completed the LED is extinguished.
The operating mode of the CPU will be STOP or RUN,
depending on the position of the function selector.

Condition
The operating mode of the CPU must be STOP. You may place the
CPU in STOP mode by the menu command PLC > Operating mode.
Overall reset
1. You may request the overall reset by means of the menu com-

mand PLC > Clean/Reset.
2. In the dialog window you may place your CPU in STOP mode

and start the overall reset if this has not been done as yet. The
S-LED blinks during the overall reset procedure.
ð When the S-LED is on permanently the overall reset proce-

dure has been completed.

1. If there is a project S7PROG.WLD on the MMC, the CPU
attempts to reload this project from MMC.
ð The MC LED is on.

2. When the reload has been completed the LED is extinguished.
The operating mode of the CPU will be STOP or RUN,
depending on the position of the function selector.

Automatic reload

Overall reset by means
of the Siemens SIMATIC
manager

Automatic reload
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A Factory reset deletes the internal RAM of the CPU completely and
sets it back to the delivery state. Please regard that the MPI address
is also set back to default 2! More information may be found at the
part "Factory reset" further below.

4.12 Firmware update
There is the opportunity to execute a firmware update for the CPU
215-2BE06 and its components via MMC. For this an accordingly pre-
pared MMC must be in the CPU during the startup. So a firmware
files can be recognized and assigned with startup, a file name is
reserved for each updateable component (see table below). After
PowerON and CPU STOP the CPU checks if there is a firmware file
on the MMC. If this firmware version is different to the existing firm-
ware version, this is indicated by blinking of the LEDs and the firm-
ware may be installed by an update request.

The latest firmware versions are to be found in the service area at
www.vipa.com

A label on the rear of the module indicates the firmware version. You
may display the current firmware version of your CPU via the Sie-
mens SIMATIC manager. To display the firmware version, you go
online with the CPU via your PG or PC and start the Siemens
SIMATIC manager. Via PLC > Module status, register "General", the
current firmware version is evaluated and displayed.

n Go to www.vipa.com
n Click on Service > Download > Firmware.
n Navigate to via System 200V > CPU to your CPU and download

according to your hardware version the zip file to your PC.
n Open the zip file and copy the files to your MMC.
n Rename this accordingly
By means of a reserved file name in the CPU 215-2BE06 you may
transfer a firmware per MMC:

Component File name
order no._release_version.ZIP

New file name at MMC

CPU Bx000... .bin firmware.bin

CP px000245.pkg px000245.pkg

Reset to factory setting

Overview

Latest Firmware at
www.vipa.com

Find out CPU firmware
version

Load firmware and
transfer it to MMC with
reserved file name

Reserved file names
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WARNING!
When installing a new firmware you have to be extremely
careful. Under certain circumstances you may destroy the
CPU, for example if the voltage supply is interrupted
during transfer or if the firmware file is defective. In this
case, please call the VIPA-Hotline! Please regard that the
version of the update firmware has to be different from the
existing firmware otherwise no update is executed.

1. Switch the operating mode switch of your CPU in position ST.
Turn off the voltage supply. Plug the MMC with the firmware files
into the CPU. Please take care of the correct plug-in direction of
the MMC. Turn on the voltage supply.

2. After a short boot-up time, the alternate blinking of the LEDs SF
and FC shows that at least a differing firmware file was found on
the MMC.

3. You start the transfer of the firmware as soon as you tip the
operating mode switch lever downwards to MR within 10s and
leave it in ST position.

4. During the update process, the LEDs SF and FC are alternately
blinking and MC LED is on. This may last several minutes.

5. The update is successful finished when the LEDs PW, S, SF,
FC and MC are on. If they are blinking fast, an error occurred.

6. Turn Power OFF and ON. Now it is checked by the CPU,
whether further current firmware versions are available at the
MMC. If so, again the LEDs SF and FC flash after a short start-
up period. Continue with point 3.
If the LEDs do not flash, the firmware update is ready.
ð Now a factory reset should be executed (see next page).

After that the CPU is ready for duty.

Transfer firmware from
MMC into CPU
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4.13 Factory reset
With the following proceeding the internal RAM of the CPU is com-
pletely deleted and the CPU is reset to delivery state. Please note
that here also the MPI address is reset to the address 2!
1. Switch the CPU to STOP.
2. Push the operating mode switch down to position MR for 30s.

Here the S LED flashes. After a few seconds the stop LED
changes to static light. Now the S LED changes between static
light and flashing. Starting here count the static light states of
the S LED.

3. After the 6. static light release the operating mode switch and tip
it downwards to MR. Now the R LED lights up once. This means
that the RAM was deleted completely.

4. For the confirmation of the resetting procedure the LEDs PW
and S are on.

5. Then you have to switch the power supply off and on.
ð The proceeding is shown in the following Illustration:

After the firmware update you always should execute a
Factory reset.

4.14 Diagnostic entries
You may read the diagnostic buffer of the CPU via the Siemens
SIMATIC Manager. Besides of the standard entries in the diagnostic
buffer, the VIPA CPUs support some additional specific entries in
form of event-IDs.
The current content of the diagnostics buffer is stored at the memory
card by means of the CMD DIAGBUF.

Every register of the module information is supported by
the VIPA CPUs. More information may be found at the
online help of the Siemens SIMATIC Manager.

Proceeding

Entries in the diag-
nostic buffer
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To monitor the diagnostic entries you choose the option ‘PLC
è Module Information’ in the Siemens SIMATIC Manager. Via the
register "Diagnostic Buffer" you reach the diagnostic window:

The diagnosis is independent from the operating mode of the CPU.
You may store a max. of 100 diagnostic entries in the CPU. The fol-
lowing page shows an overview of the VIPA specific Event-IDs.

Overview of the Event-IDs

Event-ID Description
0xE003 Error at access to I/O devices

Zinfo1: I/O address
Zinfo2: Slot

0xE004 Multiple parameterization of a I/O address
Zinfo1: I/O address
Zinfo2: Slot

0xE005 Internal error -Please contact the VIPA-Hotline!

0xE006 Internal error -Please contact the VIPA-Hotline!

0xE007 Configured in-/output bytes do not fit into I/O area

0xE008 Internal error -Please contact the VIPA-Hotline!

0xE009 Error at access to standard back plane bus

0xE010 Not defined module group at backplane bus recognized
Zinfo2: Slot
Zinfo3: Type ID

0xE011 Master project engineering at Slave-CPU not possible
or wrong slave configuration

0xE012 Error at parameterization

0xE013 Error at shift register access to VBUS digital modules

Monitoring the diag-
nostic entries
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Event-ID Description
0xE014 Error at Check_Sys

0xE015 Error at access to the master
Zinfo2: Slot of the master (32=page frame master)

0xE016 Maximum block size at master transfer exceeded
Zinfo1: I/O address
Zinfo2: Slot

0xE017 Error at access to integrated slave

0xE018 Error at mapping of the master I/O devices

0xE019 Error at standard back plane bus system recognition

0xE01A Error at recognition of the operating mode (8 / 9 Bit)

0xE0CC Communication error MPI / Serial

0xE100 MMC access error

0xE101 MMC error file system

0xE102 MMC error FAT

0xE104 MMC error at saving

0xE200 MMC writing finished (Copy Ram to Rom)

0xE210 MMC reading finished (reload after overall reset)

0xE300 Internal Flash writing ready (Copy RAM to ROM)

0xE310 Internal Flash reading finished (reload after battery failure)

4.15 Using test functions for control and monitoring of variables
For troubleshooting purposes and to display the status of certain vari-
ables you can access certain test functions via the menu item Debug
of the Siemens SIMATIC Manager.
n The status of the operands and the RLO can be displayed by

means of the test function ‘Debug è Monitor’.
n The status of the operands and the RLO can be displayed by

means of the test function ‘PLC è Monitor/Modify Variables’.

This test function displays the current status and the RLO of the dif-
ferent operands while the program is being executed. It is also pos-
sible to enter corrections to the program.

When using the test function "Monitor" the PLC must be in
RUN mode!

Overview

‘Debug è Monitor’
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The processing of the states may be interrupted by means of jump
commands or by timer and process-related interrupts. The interrup-
tion of the processing of statuses does not change the execution of
the program. It only shows that the data displayed is no longer valid.
At the breakpoint the CPU stops collecting data for the status display
and instead of the required data it only provides the PG with data
containing the value 0. For this reason, jumps or time and process
alarms can result in the value displayed during program execution
remaining at 0 for the items below:
n the result of the logical operation RLO
n Status / AKKU 1
n AKKU 2
n Condition byte
n absolute memory address SAZ. In this case SAZ is followed by a

"?".

This test function returns the condition of a selected operand (inputs,
outputs, flags, data word, counters or timers) at the end of program
execution. This information is obtained from the process image of the
selected operands. During the "processing check" or in operating
mode STOP the periphery is read directly from the inputs. Otherwise
only the process image of the selected operands is displayed.
n Control of outputs

– It is possible to check the wiring and proper operation of output
modules.

– You can set outputs to any desired status with or without a
control program. The process image is not modified but out-
puts are no longer inhibited.

n Control of variables
– The following variables may be modified: I, Q, M, T, C and D.
– The process image of binary and digital operands is modified

independently of the operating mode of the CPU.
– When the operating mode is RUN the program is executed

with the modified process variable. When the program con-
tinues they may, however, be modified again without notifica-
tion.

– Process variables are controlled asynchronously to the execu-
tion sequence of the program.

‘PLC
è Monitor/Modify
Variables’
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5 Configuration with TIA Portal
5.1 TIA Portal - Limitations

Since the VIPA-CPU is configured as CPU 315-2DP (6ES7
315-2AG10-0AB0 V2.6.) in the Siemens TIA Portal, there are limita-
tions with the configuration of the VIPA-CPU, which are in the fol-
lowing described.

The VIPA specific SFCs are not supported during programming with
the Siemens TIA Portal.

n OB 55 "Status interrupt" is not supported by the VIPA-CPU
n OB 56 "Update interrupt" is not supported by the VIPA-CPU
n OB 81 "Error in power supply" exists in the VIPA-CPU but is not

supported by the Siemens TIA Portal
n The phase shift, available for the OB 35 "Watchdog" in the Sie-

mens TIA Portal, is not evaluated by the VIPA-CPU.

n "Plant designation" and "location identifier" in the Siemens TIA
Portal are not supported by the VIPA-CPU.

n In contrast to the Siemens CPU 315-2DP with a periphery
address area 0 ... 2047, the periphery address area of the VIPA-
CPU is limited to 0 ... 1023. The diagnostic address area is 0 ...
2047 and is not limited.

n The bit memory (retentive memory) area is limited to 0 ... 1023.

5.2 TIA Portal - Work environment
5.2.1 General

In this chapter the project engineering of the VIPA CPU in the Sie-
mens TIA Portal is shown. Here only the basic usage of the Siemens
TIA Portal together with a VIPA CPU is shown. Please note that soft-
ware changes can not always be considered and it may thus be devi-
ations to the description. TIA means Totally integrated Automation
from Siemens. Here your VIPA PLCs may be configured and linked.
For diagnostics online tools are available.

Information about the Siemens TIA Portal can be found in
the online help respectively in the according online docu-
mentation.

To start the Siemens TIA Portal with Windows select ‘Start
è Programs è Siemens Automation è TIA ...’
Then the TIA Portal opens with the last settings used.

General

VIPA specific SFCs

Operating blocks - OBs

Further limitations

General

Starting the TIA Portal
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With the menu ‘Project è Exit’ in the ‘Project view’  you may exit the
TIA Portal. Here there is the possibility to save changes of your
project before.

5.2.2 Work environment of the TIA Portal
Basically, the TIA Portal has the following 2 views. With the button on
the left below you can switch between these views:

The ‘Portal view’  provides a "task oriented" view of the tools for pro-
cessing your project. Here you have direct access to the tools for a
task. If necessary, a change to the Project view takes place automati-
cally for the selected task.

The ‘Project view’  is a "structured" view to all constituent parts of
your project.

The Project view is divided into the following areas:

Exiting the TIA Portal

Portal view

Project view

Areas of the Project
view
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1 Menu bar with toolbars
2 Project tree with Details view
3 Project area
4 Device overview of the project respectively area for block pro-

gramming
5 Properties dialog of a device (parameter) respectively information

area
6 Hardware catalog and tools
7 "Task-Cards" to select hardware catalog, tasks and libraries
8 Jump to Portal or Project view

5.3 TIA Portal - Hardware configuration - CPU
The hardware configuration of the CPU and the system 200V
modules at the VIPA bus takes place in the Siemens TIA Portal as a
virtual PROFIBUS systems. For the PROFIBUS interface is standar-
dized software sided, the functionality is guaranteed by including a
GSD-file into the Siemens TIA Portal. Your project can be transferred
to the CPU via MPI interface or by means of a MMC.

1. Go to www.vipa.com > Service > Download > PROFIBUS GSD
files and download the file System_100V_-_200V_Vxxx.zip.

2. Extract the file to your work directory. The vipa_21x.gsd
(German) respectively vipa_21x.gse (English) can be found at
the directory CPU21x.

3. Start the Siemens hardware configurator and close every
project.

4. Go to Options > Install new GSD file.
5. Navigate to the directory CPU21x and choose the corresponding

file vipa_21x.gsd (German) or vipa_21x.gse (English)
ð Now the modules of the VIPA System 200V are integrated in

the hardware catalog at PROFIBUS-DP \ Additional field
devices \ I/O \ VIPA_System_200V.

General

Including the GSD-file

VIPA System 200VConfiguration with TIA Portal

TIA Portal - Hardware configuration - CPU

HB97 | CPU | 215-2BE06 | GB | 16-17 62



With the Siemens TIA Portal the CPU from VIPA is to be configured
as CPU 315-2DP (6ES7 315-2AG10-0AB0 V2.6.) from Siemens.
1. Start the Siemens TIA Portal.
2. Create a new project in the Portal view with ‘Create new

project’ .
3. Switch to the Project view.
4. Click in the Project tree at ‘Add new device’ .
5. Select the following CPU in the input dialog:

SIMATIC S7-300 > CPU 315-2DP (6ES7 315-2AG10-0AB0
V2.6.)
ð The CPU is inserted with a profile rail.

Device overview:

Module ... Slot ... Type ...

PLC ... 2 CPU 315-2DP

MPI interface 2 0 MPI interface

DP interface 2 X2 DP interface

... ... ...

Since the CPU from VIPA is configured as Siemens CPU, so the set-
ting of the parameters takes place via the Siemens CPU. For para-
metrization click in the Project area respectively in the Device over-
view at the CPU part. Then the parameters of the CPU part are
shown in the Properties dialog. Here you can make your parameter
settings. Ä ‘Parameter CPU’ on page 44

5.3.1 Virtual PROFIBUS master system

Connect and parameterize the internal DP interface at operation
mode "DP-Master".

Configuration Siemens
CPU

Setting standard CPU
parameters

Configure a PROFIBUS
master system

VIPA System 200V Configuration with TIA Portal

TIA Portal - Hardware configuration - CPU > Virtual PROFIBUS master system

HB97 | CPU | 215-2BE06 | GB | 16-17  63



1. Switch in the Project area to "Network view".
2. Connect the slave system "VIPA_CPU 21x". After installing the

vipa_21x.GSD this may be found in the hardware catalog at:
Other field devices > PROFIBUS DP > I/O > VIPA GmbH >
VIPA_System_200V > VIPA_CPU21x.

3. For the slave system CPU21x-Slave-System set the PROFIBUS
address 1.

Thus, the VIPA components can be displayed, you have to
deactivate the "Filter" of the hardware catalog.

1. Click at the slave system and open the "Device overview" in the
Project area.

2. Configure at slot 1 the according CPU 215-2BE06 of the hard-
ware catalog of the VIPA_System_200V.

Device overview:

Module ... Slot ... Type ...

Slave ... 0 VIPA CPU21x

215-2BE06 1 215-2BE06

  2    

1. Install the corresponding GSD file of your slave system in the
hardware configurator.

2. Search the corresponding PROFIBUS DP slave in the hardware
catalog and drag&drop it to the subnet of your master.

3. Assign a valid PROFIBUS address > 2 to the DP slave.

VIPA_CPU21x

Configuration of the DP
slaves
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4. Add your modules according to the real hardware assembly.

5.4 TIA Portal - Hardware configuration - I/O modules
After the hardware configuration of the CPU place the System 300
modules at the bus in the plugged sequence. For this drag&drop the
according module from the Hardware catalog to the according posi-
tion of the profile rail in the Project area or in the Device overview

Device overview

Module ... Slot ... Type ...

PLC... 1 CPU ...

DI... 2 DI...

DO... 3 DO...

DIO... 4 DIO...

AI... 5 AI...

Hardware configuration
of the modules
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AO... 6 AO...

... ...

For parametrization click in the Project area respectively in the Device
overview on the module you want to parameterize. The parameters of
the module appear in the Properties dialog. Here you can make your
parameter settings.

5.5 TIA Portal - Hardware configuration - Ethernet PG/OP channel
The CPU has an integrated Ethernet PG/OP channel. This channel
allows you to program and remote control your CPU.
n The Ethernet PG/OP channel also gives you access to the internal

web page that contains information about firmware version, con-
nected I/O devices, current cycle times etc.

n At the first commissioning respectively after a factory reset the
Ethernet PG/OP channel has no IP address.

n For online access to the CPU via the Ethernet PG/OP channel,
valid IP address parameters have to be assigned to this. This is
called "initialization".

n This can be done with the Siemens TIA Portal.

1. Install your System 300S with your CPU.
2. Wire the system by connecting cables for voltage supply and

signals.
3. Connect the Ethernet jack of the Ethernet PG/OP channel to

Ethernet.
4. Switch on the power supply.

ð After a short boot time the CP is ready for communication.
He possibly has no IP address data and requires an initiali-
zation.

The initialization via the Online functions takes place with the fol-
lowing proceeding:

Determine the current Ethernet (MAC) address of your Ethernet
PG/OP channel. This can be found as 1. address under the front
flap of the CPU on a sticker on the left side.

You get valid IP address parameters from your system administrator.
The assignment of the IP address data happens online in the Sie-
mens TIA Portal with the following proceeding:
1. Start the Siemens TIA Portal.
2. Switch to the ‘Project view’ .
3. Click in the ‘Project tree’  at ‘Online access’  and choose here by

a doubleclick your network card, which is connected to the
Ethernet PG/OP channel.

Parametrization

Overview

Assembly and commis-
sioning

"Initialization" via
Online functions

Assign IP address
parameters
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4. To get the stations and their MAC address, use the ‘Accessible
device’ . The MAC address can be found at the 1. label beneath
the front flap of the CPU.

5. Choose from the list the module with the known MAC address
(Onboard PG/OP [MAC address]) and open with "Online & Diag-
nostics" the diagnostics dialog in the Project area.

6. Navigate to Functions > Assign IP address. Type in the IP con-
figuration like IP address, subnet mask and gateway.

7. Confirm with [Assign IP configuration].
ð Directly after the assignment the Ethernet PG/OP channel is

online reachable using the set IP address data. The value
remains as long as it is reassigned, it is overwritten by a
hardware configuration or an factory reset is executed.

Due to the system you may get a message that the IP
address could not be assigned. This message can be
ignored.

1. Open your project.
2. If not already done, configure in the ‘Device configuration’  a

Siemens CPU 315-2DP (6ES7 315-2AG10-0AB0 V2.6.).
3. Configure the System 200V modules.
4. For the Ethernet PG/OP channel you have to configure a Sie-

mens CP 343-1 (6GK7 343-1EX11 0XE0) always as last module
after the really plugged modules.

5. Open the "Property" dialog by clicking on the CP 343-1EX11
and enter for the CP at "Properties" at "Ethernet address" the IP
address data, which you have assigned before.

6. Transfer your project.

Take IP address param-
eters in project
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Device overview:

Module ... Slot ... Type ...

PLC... 1 CPU ...

... ... ...

DI... 2 DI...

DO... 3 DO...

DIO... 4 DIO...

AI... 5 AI...

AO... 6 AO...

 CP 343-1 7 CP 343-1

5.6 TIA Portal - Project transfer
There are the following possibilities for project transfer into the CPU:
n Transfer via MPI
n Transfer via Ethernet
n Transfer via memory card

Currently the VIPA programming cables for transfer via MPI are not
supported. This is only possible with the programming cable from Sie-
mens.
1. Establish a connection to the CPU via MPI with an appropriate

programming cable. Information may be found in the corre-
sponding documentation of the programming cable.

2. Switch-ON the power supply of your CPU and start the Siemens
TIA Portal with your project.

3. Select in the Project tree your CPU and choose ‘Context menu
è Download to device è Hardware configuration’ to transfer
the hardware configuration.

4. To transfer the PLC program choose ‘Context menu
è Download to device è Software’. Due to the system you
have to transfer hardware configuration and PLC program sepa-
rately.

Overview

Transfer via MPI
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For transfer via Ethernet the CPU has the following interface:
n Ethernet PG/OP channel

So that you may the according Ethernet interface, you have to assign
IP address parameters by means of the "initialization".
Please consider to use the same IP address data in your project for
the CP 343-1.

1. For the transfer, connect, if not already done, the appropriate
Ethernet jack to your Ethernet.

2. Open your project with the Siemens TIA Portal.
3. Click in the Project tree at Online access and choose here by a

double-click your network card, which is connected to the
Ethernet PG/OP interface.

4. Select in the Project tree your CPU and click at [Go online].
5. Set the access path by selecting "PN/IE" as type of interface,

your network card and the according subnet. Then a net scan is
established and the corresponding station is listed.

6. Establish with [Connect] a connection.
7. Click to ‘Online è Download to device’.

ð The according block is compiled and by a request trans-
ferred to the target device. Provided that no new hardware
configuration is transferred to the CPU, the entered Ethernet
connection is permanently stored in the project as transfer
channel.

The memory card serves as external storage medium. There may be
stored several projects and sub-directories on a memory card. Please
regard that your current project is stored in the root directory and has
one of the following file names:
n S7PROG.WLD
n AUTOLOAD.WLD
1. Create in the Siemens TIA Portal a wld file with ‘Project

è Memory card file è New’.
ð The wld file is shown in the Project tree at "SIMATIC Card

Reader" as "Memory card file".
2. Copy the blocks from the Program blocks to the wld file. Here

the hardware configuration data are automatically copied to the
wld file as "System data".

The transfer of the application program from the memory card into the
CPU takes place depending on the file name after an overall reset or
PowerON.
n S7PROG.WLD is read from the memory card after overall reset.
n AUTOLOAD.WLD is read from the memory card after PowerON.
The blinking of the MC LED of the CPU marks the active transfer.
Please regard that your user memory serves for enough space for
your user program, otherwise your user program is not completely
loaded and the SF LED gets on.

Transfer via Ethernet

Initialization

Transfer

Transfer via memory
card

Transfer memory card
® CPU
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When a memory card has been installed, the write command stores
the content of the RAM as S7PROG.WLD on the memory card. The
write command can be found in the Siemens TIA Portal in the Task
card "Online tools" in the command area at "Memory" as button [Copy
RAM to ROM]. The MC LED blinks during the write access. When the
LED expires, the write process is finished. If this project is to be
loaded automatically from the memory card with PowerON, you have
to rename this to on the memory card to AUTOLOAD.WLD.

Please note that in the Siemens TIA Portal with some CPU
types the [Copy RAM to ROM] button is not available.

After accessing the memory card you can find a diagnostics entry in
the CPU. To monitor the diagnostics entries, you select Online &
Diagnostics in the Siemens TIA Portal. Here you can access the
"Diagnostics buffer". Ä ‘Diagnostic entries’ on page 56

Transfer CPU ®
Memory card

Checking the transfer
operation
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